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OTLEY CAMERA CLUB: PREPARING IMAGES FOR PRINT COMPETITIONS 

 

òThe negative is everything, the print  is all.ó ð Ansel Adams 
 

 

PREFACE 

How often do you look at posts and pictures on social media? For many it will be many times a day 
with the average time spent looking at each post being around three seconds. Why do we post 
images, is it really to share with friends or more about self-gratification. 
 
In three seconds, we cannot really get a feel for an image. Is it any good or are friends just feeling 
sorry for a sad person? At five cm square on a mobile phone, any image is going to look OK. So, if 
you are happy with just posting images on social media, this document is not for you. 
 
Now letΩs ask the question, how do I improve my photography and the answer may surprise you. 
Just slow down and look at all your pictures: the good, the bad and the ugly. What makes the good 
picture look good and what do we do with the duds. What do we have to do to make the good 
pictures look even better and how can we save time by not taking the bad pictures in the first place. 
 
We start by planning the photoshoot, taking the pictures, editing them on your computer and finally 
evaluating the results. You could do this evaluation on your laptop or desktop but for me the final 
image is best looked at when printed. All too often we look at an image on a screen and overlook the 
detail, whether it be missed focus, a poor composition, or a poor edit. At each stage, we have the 
opportunity to ruin the image often through a lack of knowledge or by rushing the process. The print 
sits at the end of the food chain so taking time to review a print enables you to see the mistakes, fix 
them and if needed seek advice. 
 
A print is a tactile entity which helps you create a long-lasting memory. And unlike a post on social 
media, you can frame a picture and hang it on your wall for all to see and enjoy for years to come. 
 
Grab a coffee, sit comfortably and ƭŜǘΩǎ work through the print process. There are a lot of steps. but 
ȅƻǳ ŘƻƴΩǘ ƴŜŜŘ an encyclopaedic knowledge to create a great picture. 
 
 
  



 

WHATS IN THIS GUIDE 

 
The aim of this guide is to explain how to prepare images for printing by the Print Club or Home 
printer. As will be seen, printing comes at the end of the post processing stage. ²ŜΩƭƭ ƭƻƻƪ ŀǘ ǘƘŜ 
various stages to try and avoid the pitfalls I encountered in the past. 
 
²ŜΩƭƭ ŎƻǾŜǊ ǘƘŜ ōŀǎƛŎ ǎǘŜǇǎ ōǳǘ ƭƛƴƪǎ ǘƻ more in-depth articles and videos on YouTube are provided 
should you wish to explore a particular subject in greater depth. And if there are any aspects you 
would like explaining in more depth, just ask one of the more experienced members. 
 
DIFFERENCE BETWEEN DIGITAL PROJECTED IMAGES (DPI) AND PRINTED IMAGES  
Our club projector can project images in a box which is 1920 pixels wide by 1080 pixels high. This 
represents an image which is around 2 million pixels which is far less than the number of pixels 
available on modern cameras. Your home TV may have a 4K screen which has a pixel dimension of 
around 3840 x 2100 pixels which is still less than the output from your camera. 
 
Like your TV, a projector contains a bright light which shines through a grid of coloured ΨlensesΩ to 
project your image onto a screen. A print however differs in that the light source shines on your 
picture, goes through the ink layer then is reflected back to your eyes from the white paper behind 
the ink. This explains why your images on your computer screen never look like your prints as one is 
an emitted light source, and the other is a reflected image. 
 
Another factor to consider is that a computer screen has a wide dynamic range due to the contrast 
between the varying degrees of brightness. This helps you watch content such as films and sports on 
your TV with a perceived high degree of detail particularly where we have a moving picture, i.e. a 
video. On a printed picture we have a limited amount of contrast, and also a more limited printable 
colour palette, due to the ink formulation and how it behaves when it is sprayed onto a sheet of 
photographic paper. To improve the Ψcolour gammaΩ printer manufacturers, increase the number of 
inks in their printers. It is generally recognised, that to get good tones in the shadows and more 
accurate colour rendition, six or more cartridges are needed. IΩƭƭ ŎƻƳŜ ōŀŎƪ ǘƻ ǇǊƛƴǘŜǊǎ ƭŀǘŜǊ ƛƴ ǘƘƛǎ 
article. 
 
Unfortunately, the online print companies who offer budget printing do not match the quality of 
most good home photo-grade printers. The budget range of online prints is typically under £2 for an 
A3 sized print whereas a good quality print starts at £5 and can rise to over £10 for a print on fine art 
paper. Lƴ ǎƘƻǊǘ ŘƻƴΩǘ ŜȄǇŜŎǘ a world beating exhibition print for a quid! 
 
Whilst our images on the club projector only have a resolution of around 2 million pixels a print 
typically has around 19 to 23 times more detail. This can be a double-edged sword as it also shows 
up any imperfections more easily. Therefore, if you are new to club competitions it may be best to 
start with PDI entries to hone your skills before you break into the world of printing. 
 
Prints can be expensive when you add in the cost of printing and mounting, typically around £6 to £8 
per picture. An image displayed on a social media application is rarely viewed for more than a few 
seconds, whereas a print is viewed for much longer and creates a memorable experience. If the 
subject in the picture is a holiday or a family member, ask the question would I hang it on my wall? If 
the answer is yes, then forget what a judge thinks, just enjoy the picture in the full knowledge you 
were the photographer. 
 



Remember the biggest advantage of printing is that it slows you down. You take time to appreciate a 
print and closer inspection helps you gain a more critical eye which in turn can help you become a 
better photographer. Presentation of the print is the final step in the process, but great prints start 
in camera. 
 
Further reading: six reasons to print 
 

PRINTING IS HARD 

Printing is actually relatively easy: you send the image to Richard who administers the print club, or 
you use a home printer. For most club competitions I would settle on using the print club ƛŦ ȅƻǳ ŘƻƴΩǘ 
already own a photo printer. You can get a lot of prints via the print club before you cover the cost 
of buying your own printer. In addition, Richard provides a mounting service for a small additional 
cost.  
 
Ask around and members will often say my prints are too dark or they look wrong ς usually an 
excuse for it was a duff image or the print was not prepared correctly. 
 
As we will see, the way to achieve a great picture needs some preparation and a good eye for detail. 
The steps are not complicated and practice files are included later for you to follow.  
 
For an in-depth ƭƻƻƪ ŀǘ ǇǊƛƴǘƛƴƎΣ L ǿƻǳƭŘ ǊŜŎƻƳƳŜƴŘ ȅƻǳ ƘŀǾŜ ŀ ƭƻƻƪ ŀǘ YŜƛǘƘ /ƻƻǇŜǊΩǎ ǿŜōǎƛǘŜΥ 
www.northlight-images.co.uk. He has loads of articles and a very large number of informative 
tutorials on YouTube. Best of all he is based in Leicester, so his recommendations are based on what 
is available to UK photographers. Another great source of videos is produced by Tim Jones the 
technical director of Fotospeed. 
 
 

A RECIPE FOR SUCCESS 

What makes a great print? Somewhat surprisingly it has nothing to do with the printer, its about the 
composition of the image and the effect it has on the viewer.  
 
Our aims for printing are as follows ς 

¶ Best possible quality 

¶ Fastest time to completion 

¶ Non-destructive workflow: change mind, rework etc 

¶ Repeatable results 

¶ Improvement over time 
 
²ŜΩƭƭ ƭƻƻƪ ŀǘ ŜŀŎƘ ǎǘŀƎŜ ǘƻ ǎŜŜ ǿƘŀǘ Ŏŀƴ ōŜ ƛƳǇǊƻǾŜŘ -  

¶ selecting the image,  

¶ getting the cropping right, i.e. the composition 

¶ making some editing adjustments, and  

¶ creating the picture including final presentation 
 
 

SELECTING THE IMAGE 

Assuming we are going to enter a competition it is best if we identify twice as many pictures as we 
ƴŜŜŘΦ 5ƻƴΩǘ ǿƻǊǊȅ ǘƻƻ ƳǳŎƘ ƛŦ ǘƘŜȅ ŀǊŜ ƴƻǘ ǇŜǊŦŜŎǘ ŀǎ ǘƘŜǊŜ ŀǊŜ ΨthingsΩ we can do to turn a bland 
picture into something eye catching. But there is no substitute for starting with a good image. 
Remember the old adage, Ψȅƻǳ ŎŀƴΩǘ ǇƻƭƛǎƘ ŀ ǘ**dΩ. 

https://www.permajet.com/blog/6-reasons-why-you-should-be-printing-your-photography/
http://www.northlight-images.co.uk/
https://www.youtube.com/results?search_query=fotospeed


Ask yourself, does the image tell a story and is the subject interesting, both to you and a wider 
audience. If you are new to the club or competitions, showing and sharing your first images can be 
nerve racking. Fear not, most seasoned members in the club are only too willing to give constructive 
and positive advice. If you have been to the recent learning sessions on getting off auto, just ask any 
of the helpers. If you encounter problems in a specific area, we can always organise further training 
events. 
 
Taking a good image is often about being in the right place at the right time. From time to time the 
club organises events or will visit a location as a group. As an example, we organised a Film Noir in 
early 2022 which was a learning curve for all members. The important thing for new members to 
remember is - all you need to bring is your camera and your enthusiasm. After a few sessions you 
will gain more confidence and start to develop your own style. 
 

MORE ON COMPOSITION AND STYLE 

Lets take a few moments and consider what makes a great portrait. The ideas here can be conveyed 
into many genres of photography even record and macro. We have to move away from the point 
and shoot and consider how we can either bend or fake reality so that the viewer sees a picture they 
would not normally see in everyday life, eg long exposure, macro. 
 
The key to portraiture is lighting the face. But there is no right or wrong composition: you choose the 
lighting which suits your style or the story you are trying to tell. Consider does it add the appropriate 
impact and does it fulfil your vision as the artist. Have a look at pictures by well-known artists and 
photographers for ideas and take advantage of any camera club or other events to practice. 
 
Settling for accepted norms is the enemy of great images. Few if any camera club photographers 
make great pictures as they get poisoned by judges who have crazy ideas based on outdated 
ŦƻƭƪƭƻǊŜΦ 5ƻƴΩǘ ōŜ ŦǊƛghtened to try something new, be it composition style or in post processing. 
 
Changing and making fine adjustments can change the mood of a picture or emphasise different 
elements so take several images for comparison purposes. 
 
Consider lighting for the picture: do I need a backdrop, either plain or patterned, or an 
environmental background to emphasise context, and also direction of lighting to add interest. 
 
Also consider ς 

¶ creating the illusion of depth to add interest 

¶ does the subject evoke an emotion 

¶ reveal the character of the subject etc and create an engagement of the subject with the 
photographer and with the end viewer. For instance, a close up of a face with deep ΨstareyΩ 
eyes. 

 
We can create the illusion of depth by techniques we have seen on our recent άDŜǘǘƛƴƎ hŦŦ !ǳǘƻ 
Řŀȅǎέ ōȅ ς 

¶ Selective focus and choosing an appropriate aperture 

¶ Choosing a contrasting background colour, e.g. light or dark background 

¶ Use of tonal values, particularly with black and white pictures 

¶ Use of colour and saturation of the colour, diffused colours as we recede into the 
background 

¶ Choice of perspective, forced, stretched, or compressed by using different focal lengths, 
sometimes by breaking the expected norms. 

 



In the advertising world your interest is captured by using what is called the ΨHookΩ. Examples are ς 

¶ Family history and, small children and babies 

¶ Emotions such as love, hate, hope, peace, shock, chaos, and 

¶ Life events, adventures and of course a cute cat 
 
To sum up, what makes a great photograph is often not an accurate portrayal of reality. It is more 
ƭƛƪŜƭȅ ǘƻ ōŜ ǎƻƳŜǘƘƛƴƎ ǿŜ ŘƻƴΩǘ ǎŜŜ ŜǾŜǊȅŘŀȅ with your eyes. Safe then to say Ψartistic licence is 
ƪƛƴƎΗΩ 
 

MAKING ADJUSTMENTS 

The first thing to get right is the composition. Remember the aspect ratio of most camera sensors is 
3:2. This differs from the 5:4 aspect ratio for many types of printer paper.  To fill a sheet of printer 
paper we therefore have to crop either image or cut a custom shaped opening on our mount board. 
For a longer explanation about aspect ratio have a look at the following YouTube video courtesy of 
Tony Northrup, and a video by David Bergman. 
 
Ideally, we would cut the opening on our mount board to suit the print, but if this is not important, 
we can make do with pre-cut mounts for A4 or A3 sized pictures. In either case we must allow a 2 to 
3 mm border on our picture which sits behind the opening on ouǊ ƳƻǳƴǘΦ ²ŜΩƭƭ ŎƻƳŜ ōŀŎƪ ǘƻ 
mounts later, but it is mentioned here to remind you not to crop your pictures too tight at the post 
processing stage. 
 
Next, we need to look at the content. Where do we place the subject of interest? Most judges have 
an opinion based on photography folklore using the, so called, rule of thirds but a trip to a museum 
or photographic exhibition will dispel some of these ideas. Artists often use the grand spiral and bird 
photographers use squares where the centre of the open beak is bang in the middle of the image. 
The simple answer is, choose what looks right and most pleasing to you as the author.  
 
Following on closely from composition have a good look around the picture: 

¶ are there any blown out highlights 

¶ light areas on the borders 

¶ is the background cluttered or has distracting areas such as bright highlights or dark spots 

¶ is the image sharp where it needs to be and are there any annoying halos 
 
 

CREATING THE IMAGE FOR PRINT 

We cover the software adjustments in a separate general post processing session. Lǘ ŘƻŜǎƴΩǘ ƳŀǘǘŜǊ 
which particular software package you use as they generally share the same basics in style and 
screen layout. If you are completely new to photography and currently do not use any specialist 
software, begin by having a read of Appendix A which promotes Ψno software no problemΩ. 
 
For ease this tutorial is based on the Adobe Photographers package ς Lightroom Classic, Photoshop 
and Bridge - as it is widely used in club photography. Remember if you get stuck ask any member of 
the committee and we will put you in touch with other members who use a particular brand of post 
processing software.  
 
Here are some common aspects which need to be covered when considering any image and 
especially prints - 

¶ Look for sensor or dust spots. These must be removed as they just ruin any print. 
 

https://youtu.be/wQ0m75bGGGg
https://youtu.be/cYwjt1ooiu8


¶ Set the crop, does it include the most interesting part of the image. Later in our examples 
ǿŜΩƭƭ ōŜ ǳǎƛƴƎ [ƛƎƘǘǊƻƻƳ /ƭŀǎǎƛŎ ό[Ǌ/ύ ǿƘƛŎƘ ŀƭƭƻǿǎ ǳǎ ǘƻ ŎǊŜŀǘŜ ƳǳƭǘƛǇƭŜ ŎƻǇƛŜǎ ƻŦ ǘƘŜ ǎŀƳŜ 
image with different adjustments. The advantage of LrC is that all our edits are non-
destructive, i.e. the original image is stored separately from the file which contains the edits. 
In short there is less of a risk that we destroy the original. 
 

¶ Once the crop is set in LrC press the (letter) I key to show the information panel. If you 
repeatedly press the I key, it will cycle through various panes showing the details about 
camera settings and the file size after cropping. 
 

¶ Most print houses such as DSL Colour Labs, used by the print club, recommend you send in 
images with a pixel density of 300 pixels per inch. Now look at the cropped print do we have 
3500 pixels for an A4 and 5100 for an A3. As long as we are not showing low numbers, say 
below 2500 pixels and 3500 pixels respectively, the lab should not have any problems 
printing your image. The latter figures represent around 200 pixels per inch which is 
generally the limit of human vision. If, however, the image size is too small, we start to lose 
overall sharpness, the common term used by judges ƛǎ Ψthe image is softΩ. 
 

¶ If this is your first attempt at creating an image for print, it is advisable to create a reference 
print which contains several copies of the same image with different levels of brightness. 
This is normally a one-off print to check your monitor and the printer produce acceptable 
brightness in your prints - and helps create a repeatable set of steps to achieve consistent 
prints. Dark prints are also one of the most common problems with printing, so we cover 
this in more detail in our examples. 
 
If you get stuck here, give me a shout and we can see what is causing the issue and hopefully 
fix it. 
 

¶ Choice of papers is ƛƳǇƻǊǘŀƴǘ ŦƻǊ ŦƛƴŜ ŀǊǘ ǇǊƛƴǘǎ ōǳǘ ǘƘƛǎ ŀƴ ŀŘǾŀƴŎŜŘ ǘƻǇƛŎ ǿƘƛŎƘ ǿŜΩƭƭ ƴƻǘ 
cover in this tutorial. With the print club the common choices are gloss or lustre. Personally, 
I would choose an oyster (a silky pearl) or lustre finish as these are more forgiving. 

 
Further viewing here which also covers what to consider. 
 
 

 DUST SPOTS 

Overlooking dust spots is by far the easiest way to ruin a good print. If repeated it will also make a 
big hole in your wallet. Have a read of this article which shows what spots look like. The best way to 
avoid the problem is to make sure all equipment is cleaned regularly. Please follow the guidance in 
your camera manual about using the dust spot removal function to clean your camera sensor. 
Caution, do not touch the sensor or innards of your camera. If you are experiencing problems take 
your camera to a ΨƳŀƛƴΩ dealer for them to undertake this cleaning process for a small fee, typically 
around £30 to £50. 
 
When changing lenses during any photoshoot, always turn off your camera and leave it a few 
seconds for the sensor to turn off completely. Most camera sensors hold a static charge which can 
behave like a dust magnet. Make sure you have your new lens ready, remove the end cap and check 
it too is clean. Then with your camera pointing downwards change the lenses as quickly as possible. 
Remember to replace all caps on the freshly detached lens. 
 

https://youtu.be/5XApE6MTWIQ
https://photographylife.com/how-to-spot-dust-on-your-dslr-sensor


Most photographers, who use a camera with interchangeable lenses, will at some point experience 
issues with dust spots. Lightroom Classic (LrC) has a tool to help you visualise spots and then spot 
them out. The spot removal tool can be found on the right of the LrC Develop screen, second tool 
highlighted in the image below ς 
 

  
 
Next to see any spots, we have to select the visualize spots option on the info bar below the image - 
 

 
 
The screen goes black and white which helps you see any potential problems 

 
 
Its best if you toggle the visualize sports option on and off a few times to locate any issues. Note the 
visualise spots tool in LrC is a bit hit and miss and for more complex cloning and healing the best 
results require a trip to Photoshop. 
 
 
 



CREATE AN INITIAL CROP 

The initial crop allows you to see the composition and get a feel for the amount of editing you may 
have to do. LrC is non-destructive meaning that you can change your mind or try different shaped 
crops. There is no hard and fast rule here. If you right click on the picture, whilst in the Develop 
module you can create a virtual copy of your image. This allows you to set various crops and 
compare them to see which looks best. The advantage here is that it takes very little additional 
memory storage for virtual copies. Talk to any photographer and they will all tell you something 
different about composition as this is a very subjective opinion.  
 
The choice is yours but bear in mind the two following scenarios. 
 

IMAGE SIZE 

When in the Develop module, press the I key several times and the information panel top left on 
your image will cycle through with different sets of information: including camera settings for the 
image and date the image was taken plus the size of the cropped image. 
 
Ideally, we require an image size which is around 300 px on the long edge for the expected size of 
your print. If you are sending your image to a print house for printing, such as DSL Colour Labs have 
a look at their advice for submitting images. This article also has useful tips for home printing. 
 
 
 

COLOUR BALANCE 

What we are talking about here is trying to match what the camera saw, to the computer screen, to 
the final print. bƻǘƛŎŜ L ŘƛŘƴΩǘ ƛƴŎƭǳŘŜ ǘƘŜ ǇƘƻǘƻƎǊŀǇƘŜǊ ŀǎ ǘƘŜ ōǊŀƛƴ Ŏƻƴǎǘŀƴǘƭȅ ƭƛŜǎ ōȅ ŦŀƪƛƴƎ ΨƴƻǊƳŀƭΩ 
lighting. This is a normal part of human vision known medically as metamerism. 
 
Your camera has a sensor based on a grid of photosites which sit behind a series of coloured lenses. 
Each receptor records a voltage which is then scanned in turn to create the grid pattern. Next the 
ŎŀƳŜǊŀΩǎ ǎƻŦǘǿŀǊŜ ǇǊƻŎŜǎǎŜǎ the data from this grid to produce an image which gets recorded on 
ȅƻǳǊ ŎŀƳŜǊŀΩǎ ƳŜƳƻǊȅ ŎŀǊŘ. This is a very simplified summary of the black box but is good enough 
unless you are a colour scientist. The key message here is the sensor and software follow a fixed 
process with no trickery along the way. 
 
Your eyes however are easily fooled, and every person has a different view of the perceived reality. 
For starters 5% of all women and 7% of men are partially colour blind. Some individuals see Red, 
Green and Blue in varying degrees of tri-chromacy but it also is thought that a small percentage of 
individuals can see an enhanced number of colours known as tetra-chromacy. Age is another factor 
as luminosity reduces as we get older which in turn affects how we see contrast and intensity of 
colour. We can see the metamerism conundrum quite easily. Stand in your living room at night and 
the lighting looks normal, now look outside and it looks blue. Take a picture of the street and it will 
look a warm orange depending on the colour of the street lighting. Now go outside and allow your 
eyes to adjust, typically around 2 minutes, your brain sets this outside environmental lighting as the 
new norm. Look back at your house and the lights look a warm orange. Which one should you 
believe is the correct colour balance? 
 
An aside: In good daylight conditions your eyes broadly see about 42 degrees each side of your 
immediate front vision. At the same time we have a visual awareness with reaches out to around 
170 degrees. An example is if a car is overtaking you, your brain becomes aware of its presence 
before it starts to see it in the main angle of view. 

https://dscolourlabs.co.uk/about/preparing-your-files


Our eyes have two types of sensors commonly known as rods and cones. The average human eye 
has around 91 million rods and 4.5 million cones.  
 
The rods are primarily responsible for your low light vision (scotopic vision) and are responsible for 
perceiving the size, shape, and brightness of visual image. They do not perceive colour and fine 
detail, tasks performed by the other major type of light-sensitive cell, the cone.  
 
There are three types of cone cells: 

¶ Red-sensing cones (60 percent) 

¶ Green-sensing cones (30 percent) and. 

¶ Blue-sensing cones (10 percent) 
 

 Cones are active at higher light levels (photopic vision), are capable of colour vision and are 
responsible for high spatial acuity. 
 

Now back to our overtaking car, in dim light our perception of colour is reduced and ROSPA research 
has shown that our field of view reduces significantly as daytime approaches dusk. The result of 
unseen change in our eyesight leads to a heightened risk of accidents around dusk on our roads 
during late October ς quoted as around a 30% increase by ROSPA. The message here is: be alert and 
take extra care. 
  
When processing images try and set the environmental room lighting, so it is roughly the same each 
time you do an editing session. A hood around your monitor can help. If you are restricted to using a 
laptop watch as your tilt the screen, the brightness and the contrast changes. 
 
Now for something controversial, if you use a PC to do your edits you may benefit from calibrating 
your screen using a colorimeter, e.g. products available from Datacolour or Xrite. These are not 
essential but remove a lot of the guesswork. The reason we calibrate PC screens is that t/Ωǎ ƘŀǾŜ ƴƻ 
common component sets, each manufacturer has different displays, display drivers and preferred 
settings to make their product look punchy and pleasing. Contrast this with an Apple device where 
we have a common manufacturing process and once the displays are calibrated in the factory, they 
tend to be more colour stable. The recommendation for Apple users is to set the screen brightness 
to around 5 or 6 brightness bars. I have a set of calibration devices and used to check the colour 
each month and my mac screen has not required any significant adjustment since its purchase in 
2015. 
 
I should say that if you intend to make prints on a regular basis, either to sell or enter in high profile 
competitions consider either buying or borrowing a monitor colorimeter. The secret to consistently 
good prints is having a workflow with repeatable steps. If you can iron out the problems with the 
equipment you the photographer become the weak link and hopefully you will get better with time 
and preparing images for producing prints. 
 
If you are new to printing a quick solution is to download the Datacolour test picture and adjust your 
monitor screen till it looks right. Now follow the advice about creating a series of test images at 
different brightness levels to fine tune your print workflow. 
 
Ok so how do we check colour balance in a picture. If we need accurate colour for say wedding 
pictures ƛƴŎƭǳŘƛƴƎ ǘƘŜ ōǊƛŘŜΩǎ ŘǊŜǎǎ or pictures being included in a book then we need take a 
reference picture of either a grey card or swatch panel. If a card is not available, just take a picture of 
the back of your hand. Take a reference picture each time you get different lighting conditions then 
load the images into LrC. On the Develop tab > basic panel > WB section use the eye dropper to click 

https://www.northlight-images.co.uk/printer-test-images/#colour_printer_test_images
https://www.wexphotovideo.com/small-grey-scale-and-colour-separation-chart-1029755/?account=853-353-2386&campaign=&group=&mkwid=_dc&pcrid=540273965654&kword=&match=&plid=&pgrid=124882232854&ptaid=pla-560424139322&si=&gclid=Cj0KCQjw4PKTBhD8ARIsAHChzRLl1PHuBJJVPTu_c9PUO1svmtY6wJ5CFI9hBpH-SzSGbBj2-nIqs1waAmsEEALw_wcB


on the grey swatch, then fine tune by moving the sliders just a small amount. If colour matching is 
not important, just use the eye dropper tool to select an area which would be a neutral grey or some 
other recognisable colour such as skin tone. If all else fails, simply adjust by eye, you may find it is 
more pleasing to warm up the tones of say sunsets and set a cooler blue tone for winter shots. 
Before we leave white balance have a look at the profile section just above the WB sliders. Click on 
the four squares ς 

 
 
This gives us a set of initial looks which are not affected 
by sliders in the basic panel and other panels. The 
profiles selection looks something like the following ς 
 
 
The profiles in LrC allow us to set an initial overall style of 
an image. These are just options provided by Adobe and 
profiles you may have obtained from third party 
suppliers. They are not a hard and fast settings for any 
individual image so feel free to experiment.  
 
Develop module profiles are just a starting point but the 
colours here are set independently to any adjustments 
we make to the sliders or development presets. 
 
 
 
 
 
 
 
 
 
 
 

 

SETTING THE BLACK AND WHITE POINTS 

Listen to many judges and we get the familiar statements Ψyour image is burnt outΩ or the darks are 
blocked. First of all set the basic exposure sliders, then look at the picture. Was the subject very 
bright or dark when the image was captured. This tells us whether there should be an abundance of 
darks or lights, now adjust the whites and blacks sliders. These two sliders affect the overall range of 
the luminance and also affects contrast. Now ƭŜǘΩǎ look at the histogram which shows the 
distribution of colours from dark to light ς see below. 
 
Check the histogram to make sure the warning triangles are not lit as they tell you when the blacks 
are clogging or we have burn out in white areas. In this example we have some black clogging. To fix 



this, hold down the shift key and click on the words Whites then Blacks to automatically set the 
values at the clipping points. To check these have been applied press the alt Key (on a PC)or option 
key (on a Mac)  and click your mouse on the actual black or white caption to the left of the sliders. 
Generally, we can accept up to 5% black clogging but no burn out spots. 
 
As we set the black and white slider clipping points, we may have to adjust other sliders in the basic 
panel again. And we may have to go round this cycle several times to set the final slider settings. 
 
 

CONTINUE THE EDIT 

Obviously, there are a lot of sliders you can adjust but these will be covered in other tutorials on 
editing images. Just make sure you have a good amount of contrast if the image requires it. The 
ΨPresenceΩ set of sliders enhance or reduce micro contrast so try changing them, remembering they 
can go up or down. A word of caution here, never remove too much clarity from faces or you get 
plastic looking skin which is a complete no-no. 
 
Go careful with the vibrance and saturation. Vibrance works mainly on the warmer tones and will 
typically enhance orange and red whereas the saturation works across the whole colour range. A tip 
here is if you increase vibrance more than 20% drop the saturation by 10% as a starting point then 
fine tune to taste. 
 
When adding sharpening ȅƻǳ Ŏŀƴ ŀŘŘ ƳƻǊŜ ǎƘŀǊǇŜƴƛƴƎ ŦƻǊ ǇǊƛƴǘǎ ǘƘŀƴ t5LΩǎ but beware of getting 
artifacts/halos around edges. As a last resort Photoshop may be able to help. We use the clone 
stamp tool, and rather than bore you with a long list of instructions have a look at Scott YŜƭōȅΩǎ 
video, starts at 1:24:00.  
 
Another Photoshop trick, which is not well known, is to create a new stamp layer, press 
ctrl+Shift+alt+E on a PC or command+shift+Option+E on a Mac. Zoom in to 100%. Right click on the 
new layer and turn it into a smart object. Now go to the filters menu and select Sharpen > Unsharp 
mask. Keep the radius and threshold at their default settings and increase the sharpen value until 
you start to see some halos. You can also experiment with the radius and threshold values but 
generally keep them low. Click on OK to commit the changes. Look on the sharpen layer near the 
right-hand side. Right click on this icon and select Ψedit and blend modesΩ. The filter values are shown 
on the pop-up form together with the blend mode. Change this blend mode to darken and click OK. 
This will remove the halos and you get a very sharp image. If it looks over-cooked just turn down the 
visibility till it looks OK then add back 10%. Prints can be sharpened more than images displayed on 
your computer screen.  
 

https://www.youtube.com/watch?v=WQomrZHb91c
https://www.youtube.com/watch?v=WQomrZHb91c


Sharpening is a complex subject and we do not have time to cover it in detail in this tutorial. In LrC 
the recommendation is to keep the totals of the sharpening plus noise reduction tools to less than 
100% as it is likely to degrade the look of your image if we exceed this recommended limit. 
 
If we have a portrait where the subject is in the middle of the cropped area it is worth going down to 
the Effects panel and applying a vignette of around -10. This just darkens to corners and edges 
almost imperceptibly but can help the eyes focus on the main subject of interest. Another effect not 
to overdo.  
 
If the subject is off-centre then have a look at the masking tool on the toolbar located just above the 
basic set of adjustment controls. This allows us to add rectangular or elliptical gradients on any part 
of the image. 
 

FINAL CHECKS BEFORE PREPARING FOR PRINTING 

Before you start the process of preparing a print always take a break beforehand. Doing this allows 
your eyes to relax and your brain to reset as it is all too easy to get a sense of attachment to a 
particular edit. In short, ǿŜ Ǝƻ ōƭƛƴŘ ŀƴŘ ŘƻƴΩǘ ǎŜŜ ǘƘŜ ƻōǾƛƻǳǎ ŜŘƛǘƛƴƎ ƳƛǎǘŀƪŜǎ. 
 
To start the review, view your image at 100% and then carefully scan across the image looking for 
any issues. Bad edits include not feathering or blending in soft edges, repeating patterns, when 
doing say a spot healing or cloning session. Always look around edges of dark to light boundaries to 
ensure there are no annoying halos. Does the image look too contrasty suggesting you have dragged 
the basic sliders too far to the right.  Conversely have you softened skin in a portrait to the point 
where it looks plastic. 
 
I learnt the following trick from Joel Grimes who is a master portrait photographer. Make the image 
small on screen and then slowly zoom in. Do you see any bright or distracting areas. The small image 
is representative of looking on a phone and the zoomed in version is looking at a big image on a 
screen and print. Repeat this a couple of times. 
 
Have you remembered to leave at least 3 mm around the image as this will get covered by the 
photo-mount. 
 
And finally, is it a pleasing image. 
 
Further viewing, Karl Taylor covers some of the essentials here. 
  
 

UNDERSTANDING THE LAB REQUIREMENTS 

The Print Club uses the basic print services to help keep costs down for members. The guides can be 
found here.  
 
You choose the image size, and the default option is set to best fit. If it matches A4 or A3 then it will 
most likely create a print with no borders. If you are not sure, talk to Richard for advice before you 
send your images. 
 
All prints you submit should have a colour space of sRGB as this is what the Lab uses to print images. 
Further down the DSCL guide page you will see references to colour profiles and proofing images. 
Adobe introduced this feature around 2012 to illustrate changes with certain types of inks and 
papers but the bad news is it sometimes ŘƻŜǎƴΩǘ ǿƻǊƪ ǾŜǊȅ ǿŜƭƭ as the effects are often exaggerated. 
Hopefully soft proofing will improve in future software releases. In short, if you are using DSCLΩǎ 

https://youtu.be/gQOr__J5jDs
https://dscolourlabs.co.uk/about/preparing-your-files


basic range of services you can generally forget these print profiles. At club level this is not usually a 
relevant factor as there are many other ΨaspectsΩ we have covered in the foregoing which will affect 
your print. And finally, remember you will never get a print to match what you see on a computer 
monitor, it simply cannot be achieved due to the difference in the way in which light interacts with 
the different technology/media. If in future, you are intending to print a set of images for a 
photography award such as LRPS then we can look at this subject in more detail and arrange for your 
images being colour checked on calibrated equipment. 
 
If this is the first time you have prepared an image for printing, I would strongly recommend you 
create a 4-image brightness test image. This will check if the images you perceive as being the 
correct brightness get printed the same. This is a one-off test and can head off the common 
complaint that images look too dark. 
 

PREPARING A 4 IMAGE BRIGHTNESS TEST USING LIGHTROOM CLASSIC 

If you get a set of prints back and they all look either too bright or too light, consider creating a 2x2 
matrix with different settings. You can either use a reference picture available on the web or select 
an image which has a good range of tones to make it easier to inspect the results. 
 
LrC makes this easy to create using the Print module. First of all, we are going to create a set of 
images with increasing brightness levels and then save them. Next, we create a new print template 
and add our set of saved images. Make sure the brightness on the target panel is reset to zero so we 
ŘƻƴΩǘ ŘǳǇƭƛŎŀǘŜ ǘƘŜ ōǊƛƎƘǘƴŜǎǎ and finally create a new image ready either for printing at home or 
generating a jpg image to send to Richard for onward transmission to the lab. LetΩs work through the 
steps using the print module in LrC. First of all, choose a test image which has a good range of tones.  

 
Select the print tab then look in the templates section and choose the 
Maximize  Size template. 
 
This should bring up a full-size image on screen. Now letΩs look at the right-
hand side of the screen. 
 
In the image settings tick Rotate to Fit. 
 
In the Layout tab make sure the margins are set to 0. The page grid should 
be 1x1 by default. Change the cell size to 297mm by 210mm.  
 
On the Page tab, tick the Photo Info box and change the option to Custom 
Text. Set the custom text to: Demo brightness adj 0. 
 
On the Print job tab, set Print to JPEG file. Colour profile sRGB and Intent to 
Perceptual. Click on Print Adjustment to set the brightness to 0. 
 

Lastly click on the Print to File button to save the file to a desired location of your choice. 
Now let us create three more files with increasing brightness, say 10, 15 and 20. 
 
Now we have our 4 test files, import them back into LrC and select them in the Library module. 
Go to the Print module again and this time select the 2 x 2 cells template. Next select all 4 images 
from the image bar and they will populate the 4 cells. In the right-hand column go to the Page 
section and make sure Photo Info is showing Filename. 
 



 
 
In the Print Job section reset the brightness to 0, and finally hit the Print button to generate the 
composite 2x2 image with titles. 
 
This file can be attached to an email and sent to Richard for onward transmission to the lab for 
printing as an A4 sized print. 
 
When the print comes back inspect the prints to see which has the best brightness setting. Now set 
the brightness value in the Print module. Note this brightness value only affects printed output and 
is not visible on your computer screen. As long as you keep your monitor brightness at the same 
level and you process your images to the same level of overall brightness you should no longer get 
any unexpected dark prints. 
 
Also see below, regarding advice on hard proofing. 
  

PREPARING AN IMAGE TO SEND TO THE LAB (METHOD 1) 

Clearly there are a lot of steps in using the LrC Print module so this method may help, but be aware 
that it misses out the brightness offset we made when using the Print module to create a JPG file. 
Unless you are happy with a custom size, it might be best if we start with say A4. 
 
First of all, we need an image which is A4 in aspect. The easiest way to do this is to go to the Develop 
module and choose the crop tool. Change the Aspect ratio to A4. Note this is just a shape and is 
identical for A3, only the size changes. 
 
Next go to the Library module, the shortcut is G for grid. Click on the Export button. The following 
page will appear. 



 
 
To begin with, we are going to create two templates which should make things easier for future 
exports. Copy the settings in the right-hand column and when done click on the Add button. This a 
window asking you to name our new template and select the location. Change the folder location to 
New Folder and type in DSCL. Click on OK to create the folder. Now on the template pop up type in 
the name of the new template as A4 Landscape. Repeat the process and change the dimensions to 
width 21.5 cm x height 29.7. Click on Add as before and just type in A4 Portrait. Select the folder as 
DSCL and click on OK to save the changes. The dimensions for A3 are 42.0cm x 29.7 cm. 
 
The next time you want to export an image start from the Library module click on the Export button 
and then click on the desired template under DSCL and it will pre-populate the right hand block in 
one go. Just click on Export and you are done. Finally go to the output folder and rename the image, 
ŀǎǎǳƳƛƴƎ ȅƻǳ ƘŀǾŜƴΩǘ ŀƭǊŜŀŘȅ ŘƻƴŜ ǘƘƛǎ ƛƴ [Ǌ/Φ 
 
The observant readers of the above will realise we can also use this method to create templates for 
exporting PDIs for our club competitions. Create another category, say OCC and enter the 
dimensions in pixels. Our new on-line software uses the following size 1600 pixels wide and 1200 
pixels high. This size for internal competitions may change in future but the competition secretary 
will publicise any changes.   
 

PREPARING AN IMAGE TO SEND TO THE LAB (METHOD 2) 

Create the templates as in method 1. To export an image from the Library module just right click on 
the image to bring up the menu and go to the export option. From there just go to the DSCL section 
and select the image. This will call up the export form as before with the values pre-populated. 
Here again remember there will be no brightness offset for dark images. A quick tip here is to add a 
0.5 stop of brightness if you are not using the LrC Print module and getting dark prints. 
 



A WARNING WHEN EMAILING IMAGES 

Sometimes when you attach an image to an email it appears in the body of the email rather than as 
an attachment. Outlook is a particular problem as it tries to reduce the size of your email by reducing 
the size of your image files. To try and stop this happening create your email as normal and then 
open File Explorer, or Finder on a Mac. Use your mouse to drag the file onto the address part of your 
email. It should then appear in the header as an attached file rather than simply being displayed in 
the body of your email. 
 

PREPARING AN IMAGE IN PHOTOSHOP 

Here again crop the image to the desired shape and save a copy. Next go to the Image menu and 
select ΨLmage sizeΩ. Type in the dimensions as before and select OK. Next go to the File menu and 
select Export > Export As. Make sure the file type is set to JPG. Set the Quality to the Max which is 7 
on the 2022 version of Photoshop CC. The size should mirror the resize adjustments we just made. 
Finally make sure the colour space is set to sRGB. Click Ok and we are done.  
 
You can create a test image in Photoshop as before, using test images with different brightness 
levels. We simply use the Camera Raw filter to set different brightness levels and save the files in a 
folder, noting the brightness setting in the filename. Next, we create a new document and open our 
test files. Copy each in turn onto our new document and use the Text tool to add titles under each 
image. Save the document as a PSD file and then do a second save as a JPG file. This JPG file can then 
be sent to Richard for onward transmission to the lab. 
 

THE HOME PRINTER 

When choosing a printer, the first question is always going to be how much do I need to spend, 
closely followed by how much does a print cost. A general overview about printers can be found 
here. 
 
In 2022 most printers on the market will print a good colour image which looks bright and has well 
saturated colours. Unless you have an expensive printer to compare the prints against it is unlikely 
you will be disappointed with the results. The big difference is that the ΨŜƴǘǊȅ ƭŜǾŜƭΩ ǇǊƛƴǘŜǊ Ƙŀǎ ŀ 
ǎƳŀƭƭ ƴǳƳōŜǊ ƻŦ ŎŀǊǘǊƛŘƎŜǎ ǿƘƛŎƘ ƭƛƳƛǘǎ ǘƘŜ ǇǊƛƴǘŜǊΩǎ ŀōƛƭƛǘȅ ǘƻ ƳƛȄ ƛƴƪǎ for small changes in colour 
tone. The range of colours a printer can print is known as Ψcolour gamutΩ. It is recognised that to get 
good colour output we need more than the four colours which are in office type printers. Six colours 
is a good starting point, but enthusiast and semi pro printers often use between 8 and 12 colour 
cartridges. This requirement becomes more apparent when we try and print black and white 
pictures. In the entry level printers, grey tones are created by mixing small amounts of colours to the 
black ink(s) which can often result in unwanted colour casts.  
 
Entry level printers tend to have small ink cartridges so the cost of ink per print is relatively high. The 
manufacturers basically sell you the printer at cost and their profit comes from selling you the ink. 
Entry level printers will typically be able to print an A4, whereas the ŜƴǘƘǳǎƛŀǎǘΩǎ printers may print 
up to A3+. The main things to watch out for are: how many ink tanks does the printer have and how 
big are the ink tanks. This latter consideration is about running costs and the short answer is the 
bigger the ink cartridges the cheaper the prints become. There is one caveat here, all printers are 
designed to be used on a regular basis and the bigger the printer the more often it should be used.   
  
There are two main manufacturers of home printers: Canon and Epson. Over the last two years both 
have listened to their customer base, and both now offer Layout Software. It is embedded into both 
Photoshop and Lightroom Classic. On a PC it appears on the File > Automate menu.  
 

https://youtu.be/N0kh6HdHweE


On a Mac the same applies for Photoshop, but for LrC , Epson Print Layout it is called from the Export 
button in the Library module. Simply change the Export To dropdown from the default Hard Disk to 
Epson Print Layout and it will send a full size .tif file to the Epson Print Layout software. The Canon 
equivalent is found on the File > Automate menu. 
 
The advantage with using this software is that there is just one page to complete.  
 
The consumer orientated printers tend to use coloured dyes and the prosumer printers use pigment. 
Both types will print fantastic prints. Dye printers are very good at printing vibrant and well 
saturated images but inks can smudge when printing black and white images on Matt papers. (If 
possible leave prints to dry for at least two hours.) If you find prints still smudge after drying you 
may need to use a protective spray to create a protective layer. Pigment inks tend to give a less 
vibrant and saturated image so you may need to bump up these two settings when developing your 
images. 
 
It is also worth noting that the more you spend on a printer or a camera you have a longer learning 
curve to get the best out of that device. So, if you intend to spend a lot on a printer take your time 
printing test images so you have a known good starting point, which will also help you in identifying 
problems with your computer set up and not issues with your images. The temptation is to overlook 
this aspect and try and make adjustments each time you make a print. Your prints will never have a 
consistent appearance, and you will waste a lot of time and money. More importantly, you stop 
enjoying printing. 
 
With Epson printers you can use the dedicated layout software. This has a tendency to print a small 
white border around the picture. If this is not the required intention then it is probably better to use 
Photoshop or Lightroom to set the paper settings to borderless.   
 
More info about home printers can be found here.  
 
 
 
 

CHOOSING PHOTO PAPERS 

 
There are hundreds of different papers on the market which can be bewildering for newcomers to 
home printing. Papers range from bargain basement up to premium quality which can cost upwards 
of £5 per sheet of A3.  
 
To begin with consider buying some general-purpose paper. Epson Photo paper is both cheap and 
has a neutral colour base. Canon also have a range of basic photo papers. When printing initial test 
prints, using the manufacturers own branded papers removes some of issues around setting the 
correct media type. Once you enter the paper type the other settings are recognised by the printer 
driver and automatically set. 
 
Where possible avoid buying paper from your local market or the bargain basement shops. These 
papers are usually poor quality and do not give consistent results. Likewise avoid cheap inks from 
the same sources as they often have gone past their sell-by-date or suffer from poor quality control. 
 
The question is: what do we do when we use a third-party paper from another manufacturer? Here 
in the UK, we have lots to choose from such as Permajet, Fotospeed, and Canson to name just three. 
Personally, I would choose Permajet Oyster as a good starting paper. It is a resin coated paper and is 

https://youtu.be/I6LdiSw8ps0
https://www.permajet.com/product/oyster-271/


reasonably durable. It has a semi-gloss finish and is relatively cheap but good quality. A box of 50 
sheets A4 starts at £25. 
 
If you are new to printing it is all too easy to spend lots of money on paper. I also use tŜǊƳŀƧŜǘΩǎ 
matt proofing paper for checking for bad edits. A box of 150 sheets of A4 costs under £30. See below 
for issues with using matt papers on Epson printers. 
 
Resin coated papers have a plastic base and covered in resin to provide the finish. They also contain 
chemicals to increase the perceived brightness by reflecting more blue light. Those chemicals are 
known as optical brighteners (OBAs) and can start to fade after two to three years. Resin coated 
papers are your everyday papers and good for printing contrasty images which have deep rich blacks 
but not recommend for printing images which are more artistic and have a soft appearance by 
design. If you use this paper for artistic images the shadows can get too black and you lose the 
appearance of pastel shades. If you have images with a high dynamic range the resulting print can 
sometimes look a little 2D. 
 
Fibre based papers such as Baryta papers These papers mimic the traditional darkroom papers and 
are made of alpha-cellulose, a posh word for wood pulp. They are typically coated with barium 
sulphate and have an off-white and slightly creamy coloured appearance making them suitable for 
warmer toned colour pictures and monochrome pictures. Papers such as Permajet Gold Silk, Fibre 
Distinction and Fibre Mono Gloss can cope with images which have a high white point and lots of 
contrast. They can sometimes make the image more 3D by having a better linearised contrast range 
across the mid shadows. Expect to pay at least twice the price for a sheet of baryta paper compared 
to resin coated equivalents. Due to the cost of such papers they tend to be only available in boxes of 
25 sheets. 
 
The third common paper is cotton rag. These are more for fine art printers and cost substantially 
more than other types of paper. If you use a lab for these print papers then you will need deep 
pockets. 
 
Most papers are available in a myriad of paper finishes: gloss, semi-gloss, matt, silk, oyster, lustre, 
photo lustre, smooth, extra smooth, textured, photo board, etc.  
 
Caution: Some Epson printers have to swap photo black ink for matt black ink when changing paper 
types from gloss to matt finishes. This can be wasteful so you may decide to stick with one particular 
type of paper coating. 
 
Choosing papers for external competition entries or awards such as with the Royal Photographic 
Society, FIAP or PAGB may need careful consideration. In this conversation Rod Whelans, who is an 
internationally recognised photo printer, looks at the various types of paper to help images stand 
out from the crowd. He talks about everyday papers such as Permajet Oyster then goes on to talk 
about alpha-cellulose papers which add depth and warmth to pictures simply by choosing a different 
paper finish.  
 
It is also worth noting that if you are entering multiple prints for different competition categories 
you are free to mix and match different paper types with different paper finishes. If, however, you 
are looking to enter a panel of pictures for an award such as LRPS, ARPS, then the pictures should 
ideally be printed on the same paper type ƻǘƘŜǊǿƛǎŜ ǘƘŜ ΨƎƭƻǎǎ-ŘƛŦŦŜǊŜƴǘƛŀƭΩ ƛƴ ǘƘŜ ǇŀǇŜǊ ŦƛƴƛǎƘ can 
ŎŀǳǎŜ ǘƘŜ ǇŀƴŜƭ ǘƻ ōŜ ƳŀǊƪŜŘ ŘƻǿƴΦ ¢ƘŜ ǘŜŎƘƴƛŎŀƭ ǘŜǊƳ ȅƻǳ Ƴŀȅ ƘŜŀǊ ƛǎ ΨŎƻƘŜǊŜƴŎŜΩ. This simply 
means the pictures should display an overall common style and finish. It also refers to subject matter 

https://www.permajet.com/product/matt-proofing-160/
https://www.permajet.com/product/matt-proofing-160/
https://youtu.be/mx02owNGglY


in some competitions which have a common theme, e.g. monochrome period portraits. In such 
competitions individual entries are scored then an overall coherence score is given. 
 
 

HARD PROOFING 

This is a technique for folks who have their own home printer and need a print of the highest quality. 
The temptation is to make trial prints and make adjustments along the way.  This method is both 
expensive in ink and paper and also wasteful. Tim Jones from Fotospeed has a simple method using 
Photoshop to make a series of test prints on just one sheet of paper. Have a look at his YouTube 
video to learn the process. 
 
When buying paper, it is worthwhile starting with a box of A4 paper to match a box of A3 paper on 
which you intend to print your final picture. If funds are tight, then do the tests on say Permajet 
Oyster 271 as this is a good all-round paper and should enable you to get a good print when you 
move over to the fine art range of papers. This applies just to papers which have a sheen, i.e. not 
matt papers. For the latter I would recommend you get a small box of say Permajet DS Matt 250 gsm 
or tŜǊƳŀƧŜǘΩǎ Ƴŀǘǘ ǇǊƻƻŦƛƴƎ ǇŀǇŜǊ to do your hard profiling. 
 

ICM/ICC PROFILES  

When you use the manufacturers photo paper you simply set the paper to the specific paper type 
such as Epson Premium Gloss. The printer understands what the media type is and the colour profile 
to use. Apart from choosing the paper type everything else is seamless. 
 
When we buy a box of paper from say Permajet they come with an information sheet which tells you  

¶ What media settings to set such as Glossy, semi-glossy, matt etc 

¶ How to get a generic ICM colour profile 
 
The media settings are based on the absorption of the paper when ink is sprayed on it. Each type of 
paper has its own characteristics and third-party paper manufacturers test their media on the 
printer manufacturers printing hardware. In short, we follow their advice.  
 
The ICC (or ICM profile) contains data which tells the printer how to colour match data being sent 
from your software - such as photoshop or lightroom. Most paper manufacturers have a download 
site where you can obtain generic profiles for your brand of printer. Try these first by printing a 
reference image, if the colours look wrong most paper manufacturers provide a free service where 
you can download a test image, print it, then send it back to them for a custom profile to be made. 
Cǳƭƭ ƛƴǎǘǊǳŎǘƛƻƴǎ ƻƴ Ƙƻǿ ǘƻ Řƻ ǘƘƛǎ ŀǊŜ ƻƴ ŜŀŎƘ ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ ǿŜbsite, e.g. Permajet profiles. They 
also provide you with instructions on how to install profiles. Setting the correct media and profile 
settings can be found in the printer handbook or on the printer ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ ǿŜōǎƛǘŜΦ 9ŀŎƘ ǇǊƛƴǘŜǊ 
model has slightly different instructions so ƛǘΩǎ not possible to describe them here. 
 
Note: some bargain basement printers do not have software drivers which take advantage of icm 
profiles. These are fine for family holiday snaps, but the quality and colour rendition may fall short in 
competitions when displayed alongside more professionally produced prints. 
 
Always keep copies of your test prints you have made with your printer profiles. Careful examination 
of these will help in deciding which paper is best for your particular image. The Canon professional 
print software also has an option to print a series of small images with different colour settings. This 
can be helpful in checking say skin tones or the colour of wedding pictures. 
 

https://youtu.be/DFFWYAC2uJc
https://youtu.be/DFFWYAC2uJc
https://www.permajet.com/product/oyster-271/
https://www.permajet.com/product/oyster-271/
https://www.permajet.com/product/ds-matt-250/
https://www.permajet.com/product/matt-proofing-160/
https://www.permajet.com/icc-profiles/


REVIEWING YOUR PRINTS 

Before you consider mounting any picture it is best to review it first to see if there are any issues. 
Ideally, they should have been picked up at the editing stage, but the following two items are 
specific to printing. 
 

1. Are there any bright spots on the image. If there are look at the print at a shallow angle. 
Notice the texture of the printed surface, is it uniform or are there anomalies with the bright 
spots. If there are then it is most likely the whites were blown out and the printer did not 
print any ink in those areas. A quick fix is to spray the image with a clear coat of artistΩs 
protective spray. 

 
2. If the print is a black and white look at the tones in the deep shadows. Compared with what 

was on your computer screen have they become totally black in the print. This usually 
happens where the paper chosen has too high a DMAX rating, i.e. too contrasty for the type 
of image being printed. The solution here is to ƭƻƻƪ ŀǘ ǘƘŜ ǇŀǇŜǊ ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ ǎƛǘŜ ǘƻ ǎŜŜ ƛŦ 
they have a better paper choice. Alternatively add a curves adjustment and make a small 
adjustment in the deep shadows by increasing the values just for the deep shadows. This fix 
is beyond the scope of this document but if you want further information on this subject, 
search for Ψ[ƛƴŜŀǊƛǎŀǘƛƻƴΩ ƻƴ ¸ƻǳ¢ǳōŜ. 
 
Another way to edit high contrast pictures, particularly black and white portraits, is to edit 
ǘƘŜ ƻǊƛƎƛƴŀƭ w!² ƛƳŀƎŜ ƛƴ tƘƻǘƻǎƘƻǇΩǎ w!² ŎƻƴǾŜǊǘŜǊΦ bŜȄǘ ƻǇŜƴ ǘƘŜ ƛƳŀƎŜ ƛƴ tƘƻǘƻǎƘƻǇ 
as a smart object. Add a camera RAW filter to the smart object and we have two separate 
sets of smart ACRΩǎ which we can use to fine tune the image and increase contrast by going 
backwards and forwards between the two filter sets. ²ŜΩƭƭ ŎƻǾŜǊ ǘƘƛǎ in a practical session 
when we look at Black and White processing later in the club programme.  
 

  
 

PRESENTATION AND MOUNTING THE PICTURE 

If you have printed your own picture, make sure you leave it at least 2 hours to dry, preferably 
overnight, and review it in daylight. The reason for the drying time is that particularly fibre-based 
papers have a wet-looking sheen when they are first printed then go dull as they fully dry. This 
phenomenon ƛǎ ƪƴƻǿƴ ŀǎ Ψ5Ǌȅ 5ƻǿƴΩ and can lead to pictures at best requiring a different coloured 
mount and at worst being rejected for mounting. Understanding and choosing the right paper can 
help here. 
 
When handling unmounted prints always use both hands to avoid ǘƘŜ ǇŀǇŜǊ ƎŜǘǘƛƴƎ ΨōǳŎƪƭŜ ƳŀǊƪǎΩ 
which stretch the emulsion surface ς particular prone to resin coated papers. It is nearly impossible 
to remove these marks so best avoided. And if the paper is of premium quality it is advisable to wear 
white cotton gloves to avoid sweaty finger prints ς the acid on your skin can destroy the coating on 
your prints if not removed asap. 
 
Before you mount any print remember to check it for any defects such as missed sensor spots, bad 
edits etc. If all OK, then the next decision is the mount colour. If your print looks light or is well lit, 
then I would choose a cream mount which tends to be the classic colour for mounts. 
 
If the image is dark or has a high degree of black and high contrast, then consider a black mount with 
a white core. The core shows through on the bezel and helps frame the picture. I personally keep a 
few different coloured mounts to just drop over a picture to see which looks best. 
 



If you are cutting your own mounts, pay particular attention to the corners when making the cuts as 
any problems here reflect on the overall presentation of the picture and in a competition may lead 
to the judge marking it down. Similarly, the adhesive used to stick the front and back boards affects 
the overall presentation so always make sure they are well attached. If a mount becomes detached, 
there is a possibility it will be disqualified particularly in external competitions. 
 
Everybody finds aligning the front and back boards somewhat problematic when mounting pictures. 
If you are using the print club, I would suggest you leave mounting to Richard as he does a great job.  
If you print your own images, then consider the following ς 
 

¶ Make a jig to help align the backboard, placement of the image, and correct placement of 
the front mount 

¶ Before you glue up the mount boards try different coloured front mounts to see which best 
suits your print 

¶ Consider using adhesive back boards when using a jig as this avoids getting adhesive on your 
expensive pictures and the fronts and backs are less likely to fall apart when being handled 
in the judging process.  
 

  CREATING A MOUNTING JIG 

¸ƻǳ ƴŜŜŘ ŀ ƎƻƻŘ ǎǘǊƻƴƎ ōƻŀǊŘ ŀǊƻǳƴŘ нпέ square and four bead edges ς either wooden or alloy. The 
top and sides of the beads should be cut and affixed to the back board to give a snug fit. The bottom 
edge just needs a small section in the middle to hold your mounts in place but give you room to lift 
the boards out of the jig when the mounts have been assembled. I had a jig made for me as seen 
below ς 
 

   
 
To mount a picture, insert an adhesive back board into the jig. Next add the picture followed by the 
front mount. Move the picture so that it is covered on all edges by the front mount. Next put a 
weight on the picture like a bag of sugar to hold it in place. Remove the front mount and peel 
around 3 inches of the protective sheet from the back board. With the picture still in place pat down 
the picture onto the revealed adhesive section. Now remove the weight from the picture and 
carefully remove the rest of the adhesive cover from the back board. Carefully let the picture drop 
onto the back board and tap it in place with a dry towel. Finally drop in the front board and it should 
register in place. Check it is correctly aligned before you press the mount into place to form a 
permanent bond. With practice this jig allows you to mount a picture in around 2 minutes with no 
mess and perfect registration. One caveat here is make sure you leave your prints for a least two 
hours to allow them to fully dry before you try to begin the mounting process. Failure to observe this 
waiting period may result in smeared ink on the picture.  
 



If you are looking at mounting fine art prints on premium papers, you may not wish to use adhesive 
backing boards so the T-Hinge method may be a better option. Logan Mounts also do a full range of 
mount cutters for cutting custom size openings to match your prints.  
 

PRINTING ON AN ECOTANK PRINTER 

The latest eco-tank printers from Canon and Epson which have six inks can print reasonably good 
colour photo prints. To the trained eye they lack some of the tonal graduation of say a 10 or 12 ink 
dedicated photo-printer but for club competitions they are more than adequate. The secret here is 
to have a custom colour profile created for your photo papers.  
 
An A3 print typically needs about 2.2ml to print one image. For reference the average ink cost for an 
Epson printer are as follows ς 
 

Printer Ink Cartridge 
Size 

Ink used 
(ml) 

Cartridge 
Cost 

Cost of ink per 
print 

Epson 8550 Eco 6 carts 70ml 2.13 £15.99 50p 

Epson P700 10 carts 25ml 2.13 £27.99 £2.50 

Epson P900 10 carts 50ml 2.13 £37.99 £1.60 

 
The Epson printers listed above need at least one print making per fortnight to stop ink clogging up 
the print head. This requires a test print (nozzle check) being made on plain paper. Note the costs 
are for illustrative purposes only and do not include the price of the photo-paper. 
 
Canon printers have similar costs for printing but the larger printers such as the A2 imagePrograf 
1000 printer also have to do print cleaning cycles which can rack up costs significantly if you are not 
printing regularly. 
 
In general, the bigger the cartridge the cheaper the ink. More info about the cost of printing using 
Epson printers can be found here. These are conservative figures as it depends on the type of picture 
being printed and the quality settings. It also assuƳŜǎ ȅƻǳ ŘƻƴΩǘ ƳŀƪŜ ƳƛǎǘŀƪŜǎ and have to print 
another copy. 
 
The latest Canon Mega-tank G range are cheaper than the Epson Eco printers but at the time of 
writing there are some aspects that potential purchasers need to be aware of. Currently the G550 is 
limited to A4 and whilst the colour images are vibrant, black and white prints have slight colour cast 
due to only have two black/grey cartridges. Currently the only driver for mac users is via air-print 
which means that you cannot fully turn off the in-built colour management within the printer. In 
some instances, this may cause a slight colour shift but unless you have another printer at hand you 
probably wont notice this small issue. No doubt Canon will correct these issues with software 
releases in coming months. Similarly, there will most likely be an A3/A3+ version to match the Epson 
8550 in coming months. At present the global chip shortage is causing production delays across the 
electronic industry and it may take up to two years to resolve. Further info on this subject can be 
found on the Fotospeed YouTube channel. 
 
 
 

PRINTING MONOCHROME IMAGES 

Both Canon and Epson have a dedicated black and white setting on their ΨǊŜŎŜƴǘΩ ǇǊƛƴǘŜǊǎΦ When 
using a Canon printer, ȅƻǳ Ǝƻ ǘƻ ǘƘŜ ǇǊƛƴǘŜǊ ǎŜǘǘƛƴƎǎ ŀƴŘ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ΨtƘƻǘƻǎƘƻǇ ƳŀƴŀƎŜǎ 
ŎƻƭƻǳǊǎΩ ǘƻ ΨtǊƛƴǘŜǊ ƳŀƴŀƎŜǎ ŎƻƭƻǳǊǎΩΦ  

https://youtu.be/eBBJVOyIfbs
https://www.epson.co.uk/en_GB/lfpinkcostcalculator
https://youtu.be/sOZIjM2a3oc


 
The Epson P700 and P900 printers have an Ψadvanced black and whiteΩ settings option which gives 
very deep rich blacks ς see the ownerΩǎ Ƴŀƴǳŀƭ ŦƻǊ ŀŘǾƛŎŜ ƻƴ Ƙƻǿ ǘƻ ǳǎŜ ǘƘƛǎ ŦŜŀǘǳǊŜ. 
 
If you use an Eco-printer for black and white images the recommendation is to get a custom colour 
profile created and let ΨPhotoshop manages the coloursΩ. More info can be found on the Fotospeed 
YouTube channel and YŜƛǘƘ /ƻƻǇŜǊΩǎ YouTube Channel. 
 
Some printers and paper combinations struggle with getting a true black and white print. Also be 
aware that all black and white prints should be viewed in daylight otherwise they may display a 
colour cast, generally a dark green. This is often caused by the printer having to mix colours with the 
blacks to change the required shade of grey. 
 
 

HINTS AND TIPS 

 
So far, we have covered a lot of ground looking at preparing images for print. [ŜǘΩǎ now look at a few 
topics to polish images ready for printing or entering in competitions more generally. 
 

¶ Always check the image for bad edits. Zoom into 100% and have a look at edges where we 
have used cut-outs or layered images. Are there any repeating patterns created by poor 
cloning etc and are there any cloned edges which need to be feathered. 
 

¶ Now for the border police, do you have any bright spots on the edges of your prints which 
can distract the viewer away from the subject. If you have then can they be covered in the 
mounting process, but remember you may have to use a custom sized mount which may 
change the overall look of the picture. 
 

¶ Similar to bright spots on the borders, do we have any distracting elements within the 
picture. Can they be fixed either by cloning or overlaying or under layering another image, 
then use masks to fix the problem. 
 

¶ If the problems referred to above are really bad then you may need to consider, subject to 
the rules for type of competition, separating the subject from the background and then 
building a new composite background. This is an advanced topic to master, as not only the 
elements of the background have to be stuck together in such a way they look real, but 
subject has a harmonious relationship with the added background. 
 

¶ Is the crop right for the mount you are using. Do you have sufficient space in the picture 
around the subjectΦ 5ƻƴΩǘ ŦƻǊƎŜǘ ǘƘŜ ƳƻǳƴǘƛƴƎ ǇǊƻŎŜǎǎ ǘȅǇƛŎŀƭƭȅ ŎƻǾŜǊǎ оƳƳ ƻƴ ŜŀŎƘ ŜŘƎŜ ƻŦ 
the print. 
 

¶ Look at the picture, does it look slightly soft, i.e. lack of definition. This usually happens if a 
picture has been over enlarged. If possible, check the number of pixels on each edge and 
divide it by the size of the print in edges. It should ideally be at least 300 pixels per inch but 
anything over 200 usually creates a good print. Anything less than 200 and you will need to 
look at resizing the image in your editing software.  
 
In Photoshop go to the Image menu and select Image Size. Now change the drop downs to 
show percent. The default is 100%. We can go up to an increase of 130%. To do this we 
repeat the following three times. Change the new percent to 110% and click on OK. Now 

https://youtu.be/GlWWwEIrz3A
https://youtu.be/GlWWwEIrz3A
https://youtu.be/aVJ7xjQ4OCQ


save the image and close it. Reopen the image and repeat the process again resizing to 
110%, click on OK and save again. Repeat again for a third time. Note we did not go straight 
to 130% as the resizing algorithm used by Photoshop works best if you keep increment to a 
small value. 
 
If you resize images on a regular basis you might want to look at the bespoke resizing 
software by On1 or Topaz labs. They have a short trial period in which you can evaluate the 
software. When resizing software do not increase the contrast or add too much sharpening 
as it will make the picture look too gritty. You may therefore have to try doing this several 
times. 
 

¶ The bigger the print the bigger its impact for the viewer. But at the same time when an 
image is printed at a larger size it should be remembered that any editing issues also 
become magnified so you must check your edits and images very carefully before you print 
them. I would always recommend that you have a break following your final edits, 
preferably overnight, as you go blind after several hours of editing. And if the image is going 
to be printed on large fine art paper consider creating a small A4 test print on cheap 
proofing paper. 
 

¶ If you have used cut outs or composited images, you will need to cover your tracks to make 
the elements appear to be just one big harmonious image. Make a new stamped layer 
command + Option + shift + E on a Mac ( ctrl + alt + shift + E on a PC). Hit Command + J to 
duplicate the stamped layer. Now select the top layer and go to the filter menu and select 
Noise > add Noise. Select a radius of 1 or 2 and hit OK. This will create a more uniform 
pattern on the image and helps hide the cut and paste effect often seen with composites. 
 

¶ For composites look at adding a colour lookup adjustment layer. Select a colour to 
harmonise the overall look, then turn down the opacity to taste. This will help cover up any 
issues where different image components had a slightly different colour balance or contrast. 
 

¶ If you have burn out in the background, try using the clone stamp or one of the healing tools 
to cover the offending areas. Alterative create a new layer and then select a colour fill for 
the layer. Move the layer under the background layer. Add a mask to the background layer, 
then get a soft brush with the opacity set to around 10%. Change the blend mode for the 
brush to darken. Now slowly brush with black over the bright spots and the colour from the 
fill layer will start to shine through. When done remember to turn the layer blend mode for 
the brush back to normal. 
 

¶ For portraits make a new stamp layer and duplicate it. Turn off the top layer. On the first 
stamp layer add a camera raw filter. Now create an elliptical mask and draw a selection over 
the face. Increate the brightness to between 0.3 and 0.5 of a stop and increase the 
sharpness by +20. Next get a brush and set the sharpness to around +40. Draw an H shape 
across the eyes, down the nose and across the mouth. Click OK to commit the changes.   
 
Now look at the overall image. If it still requires some global sharpening turn on the top 
layer and go to the Filters menu. Select Other > High Pass filter. Increase the setting to 
between 2 and 5 then click on OK. Change the blend mode to overlay or soft light. Next turn 
down the layer opacity to taste. 
 

¶ Particularly with landscapes and images which have lower contrast you need to understand 
how different paper finishes can affect the end result. If the image is artistic and has muted 



tones with low contrast, i.e., no obvious deep blacks or a high white point then choosing the 
right paper is crucial. See the paper section for more information. 
 

¶ If your final print has burn out, consider spraying the image to cover areas which are 
showing just plain paper with no ink coverage. You will have to spray the whole of image to 
get a uniform sheen on the print. 
 

¶ Are the skin colours correct, if not then it may be necessary to start again with the edit, and 
reprint as needed. This is particularly important with images of children or wedding pictures. 
Sadly, there is no quick fix here. 
 

¶ Always wait at least two hours before considering mounting your prints. This period allows 
the inks to fully dry and may also show up issues with Ψdry downΩ. 
 

¶ Always review your final prints in daylight to look for colour casts as this is likely to be the 
lighting in which they will be judged. Commercial prints maybe tungsten light balanced for 
say an exhibition room, but this is beyond the scope of this document. 
 

¶ Take care of prints as the surface is usually soft and susceptible to scratching. I use small 
protective plastic bags and consider these almost a must if the mounted print(s) is going to 
be entered in an external competition. Most mounted prints are going to be a significant 
investment. I personally hate getting prints returned which are damaged. 
 

¶ If you are submitting pictures for an external print competition you may be asked to also 
submit a digital version for display on a website or inclusion in a catalogue. This highlights a 
problem: most, prints are sharpened to a higher degree than a projected image so if you 
submit a direct copy of your ΨƛƳŀƎŜ ŦƻǊ ǇǊƛƴǘΩ ƛǘ ǿƛƭƭ ƭƻƻƪ ƻǾŜǊ-cooked on a computer screen. 
If this becomes an issue, create a copy and reduce the amount of sharpening till it looks OK 
on a good large computer screen. The rationale here is that images on a website will look OK 
and any images which are going into say a catalogue ŀǊŜ ƎƻƛƴƎ ǘƻ ōŜ ƳǳŎƘ ǎƳŀƭƭŜǊ ǎƻ ŘƻƴΩǘ 
require the same amount of sharpening for a large A3 print. 
 

¶ Do a final check of the competition rules and make sure you have completed your 
submission entry, e.g. for internal competitions you will need to register your entry using the 
online club software on the club website, members section. If you experience any problems, 
please contact the competition secretary for advice. To avoid disappointment and missing 
competition deadlines please do not leave registration to the last minute. 
 

¶ When setting the print size on a home printer the temptation is to fill the page, i.e. print 
borderless, as it allows you to use an A format sized mount. Long term this can cause the 
ǇǊƛƴǘŜǊΩǎ ǇŀŘǎ ǘƻ ōŜ filled with waste ink, which is both wasteful and may, with heavy use, 
require the printer to be serviced during its lifespan. The problem is caused by the printer 
head having to overspray the edges and a small amount of the printer pads when a 
borderless print is selected. If this is a problem, consider setting a boundary of around 1 - 
2mm. This will normally be hidden under the mount border so should not cause a problem. 
Remember most commercial pre-cut mounts cover around 3mm of the print extremities. 
 

¶ If you do not intend to use a printer for several weeks make sure and flaps and trays on the 
printer are closed to keep out dust. You might also want to consider investing in a cover. 
Similarly check with your printer manufacturer to see if you should keep your printer 
switched on. Some Canon printers perform cleaning cycles if a printer is not used for a 



specific period. With all printers it is worth printing a nozzle check if a print has not been 
made within the last two weeks. This helps keeping the print head from getting blocked 
nozzles which can result in wasted ink from cleaning cycles or even worse a maintenance 
repair by the manufacturer. 

 
 
 

USEFUL LINKS 

Canon Printers: https://www.canon.co.uk/printers/professional-photo-printers/ 
Canon PRO-300  - making a basic A3 colour print on a high quality Baryta: 
https://youtu.be/eSTDS3QW5yk 
Epson SC-P700 printer Q and A: https://youtu.be/QZEGk7qfdW8 
Epson print sizes https://www.epson.co.uk/faq/KA-01467/contents?loc=en-us 
Epson Printers: https://www.epson.co.uk/en_GB/products/printers/c/printers 
More advice on Lab printing: https://youtu.be/msOd8th4ltw 
Its not a photograph unless you print: https://youtu.be/BimI7olEmrM 
Is it worth printing your own pictures: https://youtu.be/Mpw0wXNeamI 
Free Software editors: https://www.cyberlink.com/blog/photo-editing-best-software/327/best-free-
photo-editors-windows 
Best Fine art printers: https://youtu.be/N0kh6HdHweE 
The importance of printing: https://youtu.be/mx02owNGglY 
Demystifying printing: https://youtu.be/j-uLVWABmb8 
Beginners guide to professional printing: https://youtu.be/yhCjFH3oA40 
What makes a great print - it's not just hitting the print button: https://youtu.be/DZaa2pk1SuY 
Revisiting Hard proofing: https://youtu.be/O7krY4Vru5o 
Paper Comparison for Printables: https://youtu.be/lzEUbPIm9k0 
Avoid Cropping... And Try This Instead (Photoshop):  https://youtu.be/x7r0dzzQ16M 
.ŜƎƛƴƴŜǊΩǎ DǳƛŘŜ ǘƻ tǊƻŦŜǎǎƛƻƴŀƭ tƘƻǘƻ tǊƛƴǘƛƴƎ: https://youtu.be/yhCjFH3oA40 
Improving your photo prints - Key steps you need to consider: https://youtu.be/XcSQn6HN5mk 
Does Giclee matter - Fine art print sales marketing speak (a somewhat irreverent observation): 
https://youtu.be/oQLfEtoND0Y 
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APPENDIX A - NO SOFTWARE NO PROBLEM  

[ŜǘΩǎ ǘŀƪŜ ŀ ǎǘŜǇ ōŀŎƪ ŦǊƻƳ ŀƭƭ ǘƘŜ ƧŀǊƎƻƴ and ask a simple question, do I need any specialist software 
to make a print? The simple answer is no. Think back to the film days, you took your film to the 
chemist to get it developed and printed. Now we have digital cameras we just take a USB stick 
containing images to Boots to print or send them to an online lab to print. 
 
Photographers often try and make things difficult. The most frequent outburst is Ψ!ƭǿŀȅǎ shoot in 
RAWΩΦ If you have just started on your photographic journey this not only means nothing but if you 
ŘƻƴΩǘ ƘŀǾŜ ŀƴy post processing software your pictures are always going to look flat and drab. 
The solution here is to make a few changes ǘƻ ȅƻǳǊ ŎŀƳŜǊŀΩǎ ǎŜǘǘƛƴƎǎΦ ¸ƻǳΩƭƭ ƴŜŜŘ ȅƻǳǊ ŎŀƳŜǊŀ 
instruction manualΣ ōǳǘ ŘƻƴΩǘ ǿƻǊǊȅ ƛŦ ȅƻǳ ƎŜǘ ǎǘǳŎƪ, we are always here to help. 
 
To begin with letΩs look at the colour settings.  

¶ Set the colour mode to sRGB. This just tells your camera how to handle colour to develop 
the image in-camera and store the result as an image in JPEG format on your memory card. 

¶ Now look in the shooting menu and look for image type and size. We need to set this to 
Large or Fine JPG. This tells the camera to process the image and create the largest size 
image with the finest amount of detail. 

¶ Finally set the white balance to Automatic White Balance (AWB). This lets the camera look at 
the image and best guess the overall colour of your images. 

 
The above settings are recommended as a good starting point. As you gain more experience, we can 
introduce other settings particularly when you start using software to develop your images. 
 
The sensor in your camera is where the image is generated. It is composed of a grid of photo 
receptors which record the image. A common size is 24 MP, which has 6000 x 4000 photo-receptors 
which is more than adequate to produce prints up to A3 at 300 pixels per inch. WeΩƭƭ ŎƻƳŜ ōŀŎƪ ǘƻ 
this a little later on. 
 
Your camera manufacturer probably gave you some software to let you process your images. Some 
of this is reasonably intuitive to follow, but if it looks a little daunting, we have some options to get 
you started. 
 
The changes you made in the camera settings menus lets the camera do a lot of the hard work for 
you.  
 
Now something we all must do: when you download your pictures to your computer always make 
sure you have a backup copy. Avoid making changes to these back-up images as they are your get 
out of jail card should you inadvertently screw up your working copies. Just think, if your memory 
card contained images of an important family event, this is a once in a lifetime memory which 
cannot easily be recovered. And do take care if you have to make a fresh copy of back-ups. 
 
[ŜǘΩǎ now look at the images captured by your camera. If we have a 24MP camera sensor (6000 x 
4000 pixels) and we divide the dimensions on each side by 2000 we get 3 x 2. This is the aspect ratio 
which tells us the shape of the print. We could print a picture 3 inches by 2 inches. Double the size 
and we get a 6 inches by 4 inches print, double again and we get 12 inches by 8 inches. The bad 
news is that photographic paper is a different shape e.g. 5 x 4, metric A sizes such as A4 or A3. So, to 
print a borderless picture we need to crop the image to make it fit. 
 
This requires chanƎŜǎ ōŜƛƴƎ ƳŀŘŜ ƛƴ ǎƻŦǘǿŀǊŜΦ L ƘŜŀǊ ȅƻǳ ŎǊȅ άL ǘƘƻǳƎƘǘ ȅƻǳ ǎŀƛŘ ǿŜ ŘƻƴΩǘ ƴŜŜŘ ŀƴȅ 
ǎƻŦǘǿŀǊŜΩΦ ¸ƻǳΩǊŜ ǊƛƎƘǘ L ǘƻƭŘ ŀ ŦƛōΦ Get yourself a stiff drink and ǿŜΩƭƭ ŎǊƻǇ ƻǳǊ ǇƛŎǘǳǊŜǎΦ If you are 



ǳǎƛƴƎ ŀ ²ƛƴŘƻǿǎ t/ ǿŜΩƭƭ ōŜ ǳǎƛƴƎ Print 3D, and on a Mac we use Preview. Both are free applications 
which come built in ǿƛǘƘ ǘƘŜ ŎƻƳǇǳǘŜǊΩǎ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳ. First of all, ǿŜΩƭƭ ŎǊƻǇ ŀ ǇƛŎǘǳǊŜ ŦƻǊ !п 
ǇŀǇŜǊ ǘƘŜƴ ǿŜΩƭƭ do the same for preparing an image to enter a club competition. 
 
The size of A4 paper is 297mm x 215mm at 300 pixels per inch. For PDI competitions images should 
be sized to 1600 pixels by 1200 pixels. Further information about submitting competition images can 
be found in a separate guide available in the members area of the website. 
 
 

RESIZING AN IMAGE IN MAC PREVIEW   

Open the image in the Preview application. Next go to the Tools menu and choose adjust size. 

 
For an A4 sized print, the size is normally 297mm x 210 mm. Our example image is correct on the 
width but a bit short on the height. In this case it will require a custom sized mount cutting but when 
submitting the image to the Print club it would still class as an A4 sized print. It may help Richard if 
you let him know the image size.  
 
 

RESIZING AN IMAGE ON A PC 

PC users have several free software options. Unfortunately, L ŎŀƴΩt show you any PC screen shots as I 
only use a Mac. I did find a useful document on the web. 
 
  



PRACTICE SESSION 

Now that you have read the background information let us prepare some pictures for printing. 
Import the practice files into Lightroom or Photoshop. For now, ǿŜΩƭƭ ǎǘƛŎƪ ǘƻ Lightroom. 
 

PRACTICE FILE NO. 1 

Look closely at the file are there any sensor spots. Select the spot healing tool and turn on visualise 
spots. Now do you see any problems. Use the square brackets to adjust the size of the brush and set 
the opacity to around 60%. Brush over the spots and they should disappear. If you make a mistake 
just hit ctrl + Z (command + Z on a Mac). 
 
Next have a look at the composition and set the crop. Press the I key and notice how the image size 
is changing. Try different crops both portrait and landscape. If you want to try an A4/A3 crop then 
with the Crop tool active click on the aspect and change it from original to A4. If this option is not 
available click on the custom option and enter 297:210 to create the required preset. To switch from 
a portrait crop to a landscape crop press X. 
 
Now work down through the Basic panel to do your edits. Remember to check the black and white 
clipping points. 
 
Once you are happy with the edits go to the Print module and try creating a JPEG. 
 
Also create an Export preset for DSCL as described earlier. Check the output files. 
 

PRACTICE FILE NO. 2 

Here we start with a dark file. Do the edits suggested above, now change the colour profile in the 
develop module to Black and White. Adjust the Colour Grading and see if you can match your image 
to my final image JPG image. 
 

PRACTICE FILE NO. 3 

Do we need a crop, where do we crop? Do we keep the red cloth on the wings? 
 
Aside: The cloth was put on aircraft wings to keep out dust because most aoeroplanes took off from 
fields rather than concrete runways.  If an enemy was shot at the bullets would go straight through 
the cloth and so was a good visual clue to the aero mechanics that the ammunition bay needed 
refilling. 
 

PRACTICE FILE NO. 4 

Adjust the brightness, then go to the calibration section and move the sliders to see how they affect 
colours in your picture. If you have a landscape picture the transformation can be significant and 
change the overall mood of the picture. Now hit the Reset button and edit as before. 
 

PRACTICE FILE NO. 5 

This is a typical studio shot where you ŎŀƴΩǘ decide on what the final picture should look like. See 
what you can do then have a look at my prints as an example. Also remember the image size and 
decide what size print you could make. 
 
Once you have worked through these examples have a look at your own images and see if you can 
first of all edit them to get a good competition image, then make the additional adjustments to get 
them ready for printing. 



DODGING AND BURNING 

Open the file 3D shading.psd. This appears as follows 
 

 
 
The top bar shows a gray oblong which is the 2D representation of our photograph when there is no 
directional light on the subject. We can add shading to simulate a 3D effect which gives depth to the 
picture. 
 
To create this, we simply add a new layer and change the blend mode to soft light. Next get a soft 
brush, set the opacity to 80% and a flow of between 3% and 5%. Hit the D key to set the brush 
colours to the default black and white. Slowly paint on the edges with black to add some shade. 
Swap the brush colour to white (press the X key) and paint in the highlights in the middle of the grey 
box. The overall effect is to create the illusion of a 3D pipe. 
 
This type of post processing is very common in portrait retouching, so is a worthwhile skill to learn. 
Generally, we lighten the highlights and darken the shadows to enhance the tonal range in the 
subject.  
 
²Ŝ ŎƻǳƭŘ ƛƴ ǘƘŜƻǊȅ ǳǎŜ ǘƘƛǎ ƳŜǘƘƻŘ ǘƻ ǊŜƳƻǾŜ ǎǇƻǘǎ ƻǊ ǿǊƛƴƪƭŜǎ ŦǊƻƳ ǎŀȅ ŀ ƳƻŘŜƭΩǎ face. A spot or a 
wrinkle is simply the pipe used in our example above, consisting of light and dark areas. Use the 
dodge and burn techniques to lighten the darks and darken the lights. The advantage of this 
technique is that we can just reduce the appearance of a spot or a wrinkle without removing it 
completely which usually makes a face have a plastic appearance. Wedding photo-retouchers have a 
basic rule that you do not remove any blemishes, spots etc which would last more than three weeks 
unless you have permission from the client. Instead of removing issues you simply tone down the 
ŀǇǇŜŀǊŀƴŎŜ ƻŦ ǘƘŜ ΨƛǎǎǳŜΩ ǿƘƛŎƘ ǿŀǎ ŜȄŀƎƎŜǊŀǘŜŘ ōȅ ǘƘŜ ǇƘƻǘƻƎǊŀǇƘŜǊΩǎ ŎŀƳŜǊŀ ŀƴŘ ƭƛƎƘǘƛƴƎ ǿƘŜƴ 
the picture was taken. 
 
 

CORRECTING SOME COMMON ISSUES 

In this section we will look at some of the problems you are likely to face when taking images and 
how we can fix them in post processing. Some of the examples here use Photoshop as an alternative 
to Lightroom but the changes being described are also available in Lightroom and many third-party 
non-Adobe products. 



 

CONVERGING VERTICALS AND BRIGHT SUNLIGHT 

Open the image Bolton Abbey in bright sunshine. This displays several problems we can fix. Before 
we can crop the image, we need to correct the converging verticals. At the taking stage we should 
have either used a tilt and shift lens, which is an expensive option, or taken the shot from a higher 
viewpoint. As neither option was available, we rely on software to fix the problem. Open the image 
in Photoshop and you will be presented with Adobe Camera Raw as the image type is a dng Raw file. 
We could have opened the image in Lightroom. On the Geometry dropdown we have a series of 
sliders which enable us to adjust the vertical tilt. See below ς 
 

 
 
To correct the verticals move the vertical slider to the left. Notice that the image gets squished at 
the edges. Once we are happy the verticals are OK just select the crop tool and chop of some of the 
grass in the foreground. 
 
Now go to the basic panel and make the usual adjustments as shown below. Note how we turn 
down the highlights and open up the shadows. Also when we open up the whites and blacks sliders 
we are adding contrastΦ ¢ƘŜ ǘŜȄǘǳǊŜ ŀƴŘ ŎƭŀǊƛǘȅ ǎƭƛŘŜǊǎ ŀƭǎƻ ŀŘŘ ŀ ǎƳŀƭƭ ŀƳƻǳƴǘ ƻŦ ŎƻƴǘǊŀǎǘ ōǳǘ ŘƻƴΩǘ 
overdo these or the image will become gritty. 
 
If you are using Photoshop , then open the image and check the histogram. Is either of the triangles 
lit indicating burn out in the highlights or clogged shadows ς the shadows just look black. These 
indicate the whites and blacks sliders have been opened up too far. The image may look OK on 
screen but if it is too bright, then the printer will not be able to lay down ink and the result is a small 
patch of bare paper. Always check your prints, and if this arises, consider using a protective spray to 
mask the problem or fixing the problem in Photoshop. In Photoshop we simply add a Levels 
adjustment and turn down output setting from 255 to around 240. LŦ ǘƘŀǘ ŘƻŜǎƴΩǘ ŎǳǊŜ ǘƘŜ ǇǊƻōƭŜƳ 
then it may be necessary to use the patch tool to cover the offending area. 
 
No printer can print from pure black to pure white. The best printers can manage a luminance range 
of around RGB 7 to RGB 245 but you may need to experiment with your own images. Keith Cooper 
at Northlight Images has some luminance charts which can be printed to check these values. 
 



 
 

CAMERA NOT LEVEL 

 
hǇŜƴ ǘƘŜ ƛƳŀƎŜ Ψ/ŀƳŜǊŀ bƻǘ ƭŜǾŜƭΦŘƴƎΩ ¢Ƙƛǎ ƛǎ ǘƘŜ ƛƴǘŜǊƛƻǊ ƻŦ .ƻƭǘƻƴ Priory Church, but sadly it is but  
the camera was not level. 
 

 
 
In this example we have two options: us the crop tool to rotate the image or as in the previous 
example use the geometry tools to rotate the image.  Notice both methods affect the limits of the 
available crop. 
Now take a closer look at the back wall, it is sloping away at the ceiling. Use the vertical slider in the 
geometry section to correct the lean, around -25. 








